Tracealyzer for Linux
Overview and Getting started

percepio

SENSING SOFTWARE




Software behavior depends on timing

Source code alone does not show the full picture...

Multi-threaded systems have context-switches, i.e., control-flow not visible in source code.
Impacts system performance and dangerous sporadic errors like timeouts or deadlocks.
Depends on code execution times and timing of inputs.

percepio

SENSING SOFTWARE




Tracealyzer shows what’s going on!
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Software-Defined Tracing
+ Easy to use

+ Flexible/configurable

+ Always applicable
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Tracealyzer is about Visualization
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Cleverly Interconnected
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Increasing Development Efficiency
and Software Performance

Debugging Validation Profiling
Detailed real-time behavior Code running as intended? RAM and CPU usage?
Training Documentation
Learn the software platform Visualize designs or issues
, )

“In less than 5 days from running the “Tracealyzer has doubled our development speed.

tool, we improved the performance of Problems that otherwise would take days to solve are

our graphic rendering engine by 3x!” obvious with this tool and just a quick fix. We use it all
Terry West, CEO, Serious Integrated Inc. the time.”

Alex Pabouctisids, Lead Firmware Engineer, Flyability.

Seriouvs
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"
FLYABILITY
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For Leading Companies

Percepio’s tracing tool allowed me to quickly understand and
solve serious multi-threading issues, that otherwise would
have taken least two weeks to analyze. | got started and solved
the first issue in a single day. | strongly recommend Percepio’s
tracing tools.”

Chaabane Malki, Embedded Systems Engineer, CGX Aero

—z g

ABB Robotics is using the first generation Tracealyzer in all of
the IRC5 robot controllers shipped since 2005. The tool has
proven its value many times in all corners of the world.”
Roger Kulldng, Global System Architect, ABB Robotics.

N\ A

“The many system views of the Tracealyzer from Percepio
makes it easy to quickly find solutions that we have not
seen using (Wind River) System Viewer. The visualization has
several advantages over the system viewer and makes it
easier to understand system behavior. This tool would be of
great use for us.”

Johan Fredriksson, Software Architect, SAAB AB.

”In today’s tough competition with time-to-market pressure
constantly increasing, visualization support is natural for
software developers in order to produce software of higher
quality, in shorter time and at a lower cost. We choose
Tracealyzer from Percepio.”

Jorgen Appelgren, R&D Manager, Atlas Copco Rock Drills

J

AltlasCopco
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For Leading Software Platforms

m Tracealyzer for VxWorks

é_e ] FreeRTOS+Trace M i cri " M uC/Trace

Tracealyzer for Linux
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-
[Eh Tracealyzer for Linux - CAsrc\XPDew Tracealyzer\trunk\Tracealyzer\Brands\TzForLinux\bin\Release\demo_trace\kernel\metadata

|Fi|e Find View Bookmarks LTTng Help

I: konsole: 3062 |- a

demo.out: 8133 I-

B kworker/0:0: 4345 |

B konsole: 3092 |

- |ActorReady: kwarker/0:0: 4345 |
' "-|Actorﬂeady:konsole:3032 |

" read(FD-9)

_J,-—-I write{FD-1) returns (after 100ps) |
- -I Actor Ready: kworker/0:0: 4345 |
-I Actor Ready: demo.out: 5133 |

‘ {Adorﬂeady:konsole:&ﬂm |

| read(FD-8)

. -I Actor Ready: kworker/D:0: 4345 |

demo.out: 5133

| "'{Actorﬂeady:konsole:&ﬂﬂ? |

I'l, s read(FD-9)

_____________________ - \\-I write{FD-1) returns (after 68 ps) |
- -I Actor Ready: demo.out: 5141 |

- —|Ac10rReady: demo.out: 5142 |

B kworken0:0: 4345 |

B konsole: 308 |

demo.out: 5133 |

- —|Ac10rReady: demo.out: 5143 |

| wnite(FD-1) ook |

1 Actor Ready: kworker/0:0: 4345 |
1Adorﬂeady: demo.out: 5133 |
'1Adorﬂeady:konsole:m |

{ Actor Ready: kworker/0:0: 4345 |
-I Actor Ready: konsole: 3092 |

demo.out: £143 |

demo.out: £142 |

demo.out: £141 |

\\,

| | read(FD-%)

\-| write(FD-1) returns (after 75 ps) |
sem_wait(00304C1A8) blocks |

""" ——| [SimpleUserEvent] SimpleUserEvent, 0,06279052 |

—— sem_wait{0x0804C198) blocks |

read(FD-0) blocks

Actor Information

- (Mo Actor Selected)

View Caontrols

View size (389 (us)
W Grd [100 (us)

Zoom In

W Auto

Zoom Cut ‘

Actor Instances: 6587 of 6587
Kemel Notices: 5448 of 5448
Kemel Objects Uses: 7000 of 7000
Kemel Service Calls: 6171 of 20922
[] Futex: 0 of 836

[w] 10: 6104 of 6104

[] Socket: 0 of 13755

[] Unknown: 0 of 100

UST: 67 of 67

User Events: 1090 of 1050

1:26:30.834 409 (h:m:s.ms.ps)

Main Trace View: Vertical time-line showing task scheduling, interrupts, kernel service calls

and custom “User Events”. Filter the display using the ”View Filter” in the bottom right.
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(1 FD-3 (FileDesd) = | B |
File  View  Filter Tasks  Filter Calls
Timestamp Actar Event Block time j Timestamp: 2330215435
2320125491 [Prinfocenter O read - Actor: [ bash (2)
2330135741 [Juinfocenter O read ZnETE TER
2320214679 [ bash @ read 1.880 SR LREEITEL
Parameter:  N/A
2330215439 [P bash (2 O read 469
2330215508 [ bash (2) O read Goto Entry/Exit Event |
2330215518 [Jbash (2 D read 299
Show in Trace |
2330216216 [P bash (2) D read
2330216 555 [ bash Dread
23:30.216572 [ bash D read 277
2330216 245 [ bash O read
2330227963 [ kanscle O write
23:30230.241 . konsole D read
2330220743 [ konsole Diread
2330235447 . kinfocenter Ohwirite
2330238 460 [ kinfocenter Ohwrite
2330235514 . kinfocenter O write
23:30241.522 . kinfocenter O write
23:30.241.528 [ kinfocenter O write
2330242142 . kinfocenter Orwrite
2330242 158 [ kinfocenter Diread
2330242 245 . kinfocenter O write
23:30.242 217 [ kinfocenter Ohwrite
2330242752 . kinfocenter O write j

Kernel Object History: Double-clicking on a kernel call in the main trace view opens this view, |:IEI'CE|:III:I

showing the list of events for the same kernel object (e.g., File Descriptor or Semaphore ). S ENSING SOFTWARE
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~
[Z Communication Flow =NREN X

File  View  Filter Actors  Filter Objects  Zoom

- Received by
El- demo out: 5142
B- Sends to objects
& FD-1
-- Futex-00000000E 7627878
[0 deme.out 5133 &- B0B04CTAB
- Futex-000000000804C1A8
- Receives from objects
& (x0804C198
-- Futex-000000000804C158
- Futex-00000000B7627878
- Mutex/bi-directional objects
= Communicates with actors
E| Receives From
. [@-demo.out: 5133
| [-demo.out: 5141
- Sends To
.. Shares Mutexes,/bi-directionals with
= Sent to by
B} dema.out: 5141
B- Sends to objects
- FD-1
- (0B04C198
-- Futex-000000000804C158
-- Futex-00000000E7627278
- (0204C1A8
- Futex-000000000804C1A8
- Receives from objects
- FD-0
- Mutex/bi-directional objects
= Communicates with actors
- Recsives From
= Sends To
- demo.out: 5133
[#- demo out: 5142
- Shares Mutexes.bi-directionals with

Futex-00000000BFE34F 32
Futex

Futex-00000000E762C058
Futex

m
[T

Futex-00000000B7602668
Futex

00804C1A8

PthreadSemaphore,

Futex-000000000804C1A8

Futex

Futex-00000000B7627878
Futex

[0 demo out: 5134 [] demo.out: 5142

Futex-000000000804C128

Futex

[[] demo.out: 5141

[
[1]

Communication Flow: Auto-generated summary of dependencies between threads and
kernel objects. Can be generated for a selected interval, or for the whole trace.
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[Fh Horizontal View - 2 views = | B S

Views  Resolution Zoom  Customize

CPU Load Graph- CPU 0 X
a0 % M tzzh =]
. B bashi3)

0 B bash(4)
D% B tzsh (5 -
B bash(T)
B0 % B flush-2:0
B haveged
40 % B inimklog
. B jbd?isda?-8
0% B kdedt
0% . B kinfocenter
- . I . - . B konsole
0% I ..I.ll-. I l - - —_ B krunner

B e =t men amm | W sofindd

0%

B kwin

23:30,000.000 73:40,000.000 23:50.000.000 — -
CPU Load Graph-CPU 1 x|
70% B bash )
B bzsh(2)
60 % B bashig) _
B bash (6
50 % B tzsh (T
Bl dclphin
40 % B flush-2:0
B o fzd-fuse
0%, m B ovfsd-fuse(2)
B hzveged
0% - B jbd?isda2-2
- I B foeds
10% =N = ..I-ll iy = | B khogeosged
0= - - . I . -- B kinfocenter
" | 23:30.000.000 73:40,000.000 23:50,000.000 = ':"”5"":'3 -

CPU Load Graph: Displays the relative usage of CPU time, per thread and time interval on

each processor core. Double-click on intervals to see the details in the main trace view. pPercepia

SENSING SOFTWARE

The interval displayed in the main trace view is indicated using a grey outlined rectangle.



Views Resolution Zoom  Customize
User Event Signal Plot _}(I (Mo Selection)
1 Bl SimpleUserEvent I
0.8
06
04
|
I
02
I
0
0.2
' Zoom In | i
-0.4
1L Zoom Out |
1 ||
-06 ) L IE———
) L1
1\ (eron ]
-03 write(FD-1) returns (after 7T ps) |
sem_wait{0x0304C1A8) blocks |
T [SimpleUserEvent] SimpleUserEvent, 0,08273052
-1
1:26:37.000.000 1:26:38.000.000 1:26:35.000.0 1 e 198) I
. |
[SimpleUserEvent] SimplelserEvent, -0,637424

User Event Signal Plot: Displays a plot of data arguments in “User Events”, can be used for DEFEE[:III:I

continuous input signals, state variables, or any data of interest.
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(= Event Log EI@

Window Find  Formatting

[1:26:33_657.318] Context switch on CPUD to Unknown: swapper/0 j Filters

[1:26:33.661.661] Actor Ready: H11-NOTIFY: 511 [ Include only lines matching at least one of
[1:2€:33_€€1_€€8] RActor Beady: demo.ount: 5143

[1:26:33_€€1.689%] Context switch on CPUD to X11-NOTIFY: 511 i
[1:26:33_€€1.705] recw(???)

[1:2€:33_.8€1.720] Context switch on CPUQ to demo.out: 5143

[1:2€:33_€21.750] [SimpleUserEwvent] SimplelUserEvent, -1

[1:2€:33_€£l1.7c4] Context switch on CPUD to Unknown: swapper/0

[1:2€:33_€71.239] Actor Beady: kwin: 1100 =

[1:2€:33.871.281] Context switch on CPUOQ to kwin: 1100 N
[1:2€:33_€71.372] recw(?7?7?) 1 L
[1-:2€-33_€71_4&8] Context switch on CEUD to Unknown: swapper/0 i .

[1:26-33_£71.833] Letor Ready: demo_out: 5143 [ Exclude entries matching at least one of
[1-2€-33_€71_845] Context switch on CPUD to demo_out: 5143 L
[1:2€:33_.671.868] [SimplelUserEvent] SimplelUserEvent, -0, 339802&7

[1:2€:33_€71_87¢€] Context switch on CEUD to Unknown: swapper/0

[1:2€:33_€74.045] Actor Beady: H11-NHOTIFY: VBoxClient: 30&

[1:2€:33_€74_0€€] Context switch on CPUD to X11-NOTIFY: VBoxCliemt: 30&

[1:2€:33_674.070] FUTIEX WAIT (Futex-000000000BCEEAR4} returns after 00352 ps

[1:2€:33_.6€74.075] FUIEX WAKE (Futex-0000000008CEEAD0) -
[1:26:33_674.083] FUIEX WAIT (Futex-0000000008CBERR4) blocks F I
[1:2€:33_€74.050] Context switch on CEUQ to Unknown: swapper/0

[1:26:33_681.572] Letor Deady: demo.out: 5143 [ Exclude entries before timestamp

[1:2€:33_€81.552] Context switch on CPUD to demo.out: 5143

1:26:27.746.605
[1:2€:33.€82.030] [SimpleUserEvent] SimpleUserEvent, -0,5921147 | -

[1:2€-33_€82.042] Context switch on CPUD to Unknown: swapper/0 I Exclude entries after timestamp
[1:Z2€:33_€8€.753] Actor Ready: H11-NOTIFY: 511

[1:2€:33_€8€.812] Context switch on CPUD to H11-WOTIFY: 911 |-|:25:45'EL"-I‘d"‘:-}I'1Il3

[1:26:33_€86.824] recw(???) M
[1:2€:33_€8¢€.839] Context switch on CPUQ to Unknown: swapper/0 ﬂ

[1-:2€:-33_€92_.111] Actor Ready: demo.ount: 5143
[1:2€:33_€92.125] Context switch on CPUD to demo._out: 5143
[1:2€:-33_€692_14¢] [SimplelUserEwvent] SimpleUserEvent, -0, 9822872 E|--TIECE Everts -
[1:2€:33_.€92.153] Context switch on CEUD to Unknown: swapper/0 H C,:,nte;d Switches
[1:2€:33_.702_.23€] Actor BReady: demo.out: 5143 Kemel Services
[1:2€:33_.7T0Z.2€1l] Context switch on CPUQ to demo.out: 5143 KEH‘lE| Matices

Sources

m

[1:2€:33_.7T02.3058] [SimpleUserEwvent] SimpleUserEvent, -0, 96858232 E| User Events
[1:2€:33_.702_.323] Context switch on CEUD to Unknown: swapper/0 SimpleLlserEvent L
[1:2€:33_712.818] Actor Ready: H11-NOTIFY: 511 j

Event Log: Displays a textual list of the event timeline of the main trace view, with filtering |:IEI'CE|:III:I

and color coding. Exports traces in text format for comparisons and custom analyses. S ENSING SOFTWARE




Raw Trace View

[El Raw View - C:\Program Files (xB6)\Percepio\Tracealyzer for Linwx\demo_trace\kernel\metadata [ =T

Window  Zoom  Export

I3 ST U TIISROEXISXYZETLEILLIOLC DI YSSES5555555555555 B

B S S22z 8 HS= EE Ll gL,BO=s = LIz e2os =5 o a0 0 a :26:59. sched_wakeup = _pid = _comm = "¥11- ", fid = . _prio = . _success = 1, _target_cpu = -
2=2wfs2 %gp%—%%ég DKE%Q@Q% 525‘&.13 2 13._‘?_ T ® %g ﬁ E E E E E g ﬁ E E E % % % % 15:26:59.0928940] sched_switch: { CPU=0} {_pid =0} _prev_comm = "swapper/0", _prev_tid = 0. _prev_prio = 20, _prev_state =0, _next_
2 25=5z3EH =5 BRE 3Rz 8288828 2222 ge2g2888255s 5 (152659092890 ext syscal: (CPUD}{ ret =0}

- :;-I:G‘E‘—” =& 8@;_‘"‘ =] §m;;cg§‘° M o 2AS25232E2222225F3533 15265909291}63]5yssocke{call{CFUﬂ}{caII 10, _args = (xB720C050 }

=H=d | = o= i zZa QW w W m e e o e eSS 2 159655 0929130] exit_syscall: { CPU=0}{ ret=-11}
N = = RE BZ222228388 288wy [[15:25550525156] sys nanosleep: {CPU=0] { _ratp - 0xB720CT70, mntp - (xB720C178 ) _ _

& 85 Y53 |[15:26:59.0929223] sched_switch: { CPU=0}{ pid =906 { _prev_comm = "X11-NOTIFY", prev_tid = 911, _prev_prio = 20, _prev_state = 1,
15:26:59.0946014] sched_wakeup: { CPU=0}{ _pid =0} _comm = "demo.out”, _tid = 5143, _prio = 120, _success = 1, _target_cpu =0
15:26:59.0946165] sched_swrtch:{CPUﬂHjid =0} _prev_comm = "swapper/0", _prev_tid =0, _prev_prio = 20, prev_state =0, _nest_

- - 15:26:59.0897797 d 15:26:59.0946230] exit_syscall: {CPU=0}{ ret=0}
15:26:59.0946379] sys_getcpu: {CPU=0}{ cpup BSOFEFS50, _nodep = 00, _tcache = B0 }
- 15:26:59,0946385] exit_syscall: { CPU=D}{ Tet = 0}
15:26:59.0946402] sys_clock_gettime: { CP=0} { _which_clock = 1, _tp = (xB50FEFDO } L
- = - - 15:26:59.0946407] percepiodemo simpleussrevent: { CPU=0}{ _channel = "SimpleUserEvert”, _val = 0,9822872 } 3
- n = — - 15:26:59.0946471] exit_syscall: { CPU=0}{ ret=0}
15:26:59.0946433] sys_nanosleep: {CPU=0} { rqtp = (xB50FF238, _mtp = G0 }
- 15:26:59.0946479] sched_switch: { CPU=0}{ _pid =5133 }{ _prev_comm = "demo.out”, _prev_tid = 5143, _prev_prio =20, prev_state =1,
15:26:59.1047026] sched_wakeup: { CPU=0}{ _pid =0 { _comm = "demo.out”, _tid = 5143, _prio = 120, _success = 1, _target_cpu =0}
= - 15:26:59.1047188] sched_switch: { CPU=0} { _pid =0 }{ _prev_comm = "swapper/0", _prev_tid = 0, _prev_prio = 20, _prev_state =0, _next_
- :26:59.1047233] exit_syscall: { CPU=0}{ ret=0}
_ 15:26:59.1047364] sys_getepu: { CPU=0} { _cpup = (xB50FEF50, _nodep = 0x0, _tcache = (0 }
_ 15:26:59.1047368] exit_syscall: { CPU=0}{ ret =D}
15:26:59.1047381] sys_clock_gettime: { CPU=0} { _which_clock = 1. _tp = xB50FEFDD }
15:26:59.1047386] percepiodemo simpleuserevent: { CPU=0}{ _channel = "SimpleUserEvent”, _val = 0.9921147}
= - _ = = 15:26:59.1047388] exit_syscall: { CPU=0}{ _ret =D}
- - = 15:26:59.1047411] sy=_nanosleep: {CPU=0} { _rqtp = (xB50FF288, _mtp = 00 }
15:26:59.1047464] sched_switch: { CPU=0}{ _pid = 5133 H{ _prev_comm = "demo.out”. _prev_tid = 5143, _prev_prio =20, _prev_state =1.
= - S = — N i — 15:26:59.1148151] sched_wakeup: { CPU=0}{ _pid =0 H _comm = "demo.out”. _tid = 5143. _prio = 120. _success =1, _target_cpu =0}
= - 15:26:59.1148332] sched_switch: { CPU=0}{ _pid = 0 {{ _prev_comm = "swapper/0", _prev_tid = 0. _prev_prio = 20, _prev_state = 0. _next_
- - - 15:26:59.1148403] exit_syscall: { CPU=0}{ ret=0}
15:26:59.1148582] sys_getcpu: { CPU=0} { _cpup = (xB50FEF50. _nodep = 0. _tcache = (el }
_ . 15:26:59.1148589] exit_syscal: {CPU=0}{ ret=0}
- _ i — = 15:26:59.1148609] sys_clock_gettime: { CPU=0}{ which_clock = 1, _tp = xB50FEFDD }
15:26:59.1148615] percepiodemo simpleuserevent: { CPLUI=0 } { _channel = "SimpleUserEvent”, _val = 09980267 }
_ _ u_ _ Zoom To Selection lexit_syscall: {CPU=D}{ ret=0}
— — _ Isys_nanoslesp: {CPU=0} { _rgtp = (xB50FF288, _mmip = (<0 }
= - Zoom Out - Show Full Trace sched_switch: { CPU=0}{ _pid =5133 H _prev_comm = "demo out", _prev_tid = 5143, _prev_prio = 20, _prev_state = 1,
- I isched_wakeup; { CPU=01T_pid = 0 }{_comm = "X11-NOTIFY" id =911, _prio = 120, _success = 1, _target_cpu = ﬂ}
— Focus All Views On Selection 'sched_switch: { CPU=01} {_pid = 0 }{_prev_comm = "swapper/0". _prev_tid = 0, _prev_prio = 20, _prev_state = 0, _next_
= N Show C - et syscal (CFU-D Mt = 03
= - = ow Lommunication FHow sys_socketcall: { CPU=0T { _call = 10, _args = (xB720C050 }
- Statistics Report exit_syseall: {CPU=0}{ ret=-11}
- L LODU-ON T ety = (kB720C170, _rmtp = (xB720C178 }
Show In View 3 Main View 506 H _prev_comm = "X11-NOTIFY", _prev_tid =911, _prev_prio =20, _prev_state =1,
ZoaT i =0 H _comm = "kworker/| tid = 4345, prio = 120, _success = 1, _target_cpu=01}
New Trace View =0 H _comm = ")&'org" _tid =692, _prio = 120, _success = 1, target cpu=0}
- = = B = 0 H{ _prev_comm = "swapper/0", _prev_tid = 0._prev_prio = 20, _prev_state = 0, _next_
— _ = [15 '59.1249025] sched swrtch {CPU 0 }{ _pid = 43}45}{)@\1’ comm = "kworker/0:0", _prev_tid = 4345, _prev_prio = 20}, _prev_state =
= = 514
= = 152703 0887787 | [[15:2659. 1249583 sys select TCPU=0}1 =15, inp = BaBFCE2290, _outp = 0, _evp = (D), _tvp = (xEFC62238) i
ﬂ r
15:27:01.4987017  lttng-sessiond: 3833
\

Displays all LTTng events unfiltered, with (almost) no analysis. Works directly from disk to allow for

viewing very large traces. You may select and open an interval in the other Tracealyzer views. pEFCEp|D
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Other Views Provided

* Kernel Object Utilization

— Watch gueue sizes over time
* Kernel Call Intensity

— Check the rate of kernel calls

e Kernel Blocking Times

— See blocking on kernel calls

e Scheduling Intensity

— The rate of context-switches

* Statistics Report

— Timing and CPU usage

— Descriptive statistics

— Timing distributions per job
* Heap Memory Allocation

— Malloc/free over time

e Actor Instance Graphs
— Plot the timing of each job




Tracealyzer for Linux relies on LTTng

Application Software

User-Space Events

\ 4

LTTng

Host PC

Tracealyzer for Linux

N

A

Kernel Events

Linux Kernel

Target System CPU

LTTng v2.x is the defacto standard for Linux tracing and
is included in most distributions. Since kernel v.2.6.38
LTTng does not require any kernel patching. But it
works also on older kernels from v2.6.32.
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Tracing with LTThg

Install LTTng
— See https://Ittng.org/docs/#doc-installing-lttng

Create a trace session
— 1lttng create my-session

Select what kernel events to enable
— lttng list --kernel // shown the available kernel events
— 1lttng enable-event --kernel sched switch[, ...] [--all]
— “sched_switch” should always be included

Select any userspace events to enable
— lttng list --userspace // shown the available userspace events
— 1lttng enable-event --userspace [process:tracepoint] [--all]

Start tracing
— sudo lttng start // default output is ~/lttng-traces

Stop tracing

— sudo lttng stop
— sudo lttng destroy // closes the trace session

Learn more about LTTng at https://Ittnhg.org/
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Running on Linux

* Running Tracealyzer on Linux requires Mono, the

Open Source .NET environment.

— Check if already installed (mono --version)
— Otherwise get it from http://www.mono-project.com/

* Download TracealyzerForlLinux-2.7.5.tgz or later
— From http://percepio.com/tz/downloads/

* Extract the .tgz archive to any suitable location
 Open a console and run mono TzForLinux.exe
— You get 30 days free evaluation on registration

 To open an LTTng trace (a directory of files), select File ->
Open and then locate the “metadata” file.
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Creating "User Events” from your code

Old detailed method: LTTng tracepoint
#include <lttng/tracepoint.h>
TRACEPOINT_EVENT (percepiodemo, simpleuserevent,
TP_ARGS(char*, channel, float, val),
TP_FIELDS( ctf_string(channel, channel) ctf float(float, val, val) ) )

char* channel = "SimpleUserEvent";
tracepoint(percepiodemo, simpleuserevent, channel, val);

New easy method: tracef, a printf-style interface for LTTng tracepoint

#include <lttng/tracef.h>

tracef(“Hello world: %d", myValue);

s P

\-| write(FD-1) returns (after 75 ps) I
sem_wait{0x0B04C1A8) blocks |
""" - —| [SimpleUserEvent] SimpleUs erEvent, 0,06279052

New even easier method: Just write to ”/proc/Ittng-logger” I

echo -n ‘Hello world!' > /proc/lttng-logger

| | sem_wait{0x0804C188) blocks |
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Configuring "User Events” in Tracealyzer

Tracealyzer only displays recognized LTTng events. The “User Events” must therefore be specified in a
”Platform Extension” file, added in File -> Settings. To see ALL LTTng events, use the “Raw Trace View”.

Example: PercepioDemo.xml
<?xml version="1.0" encoding="utf-8"?>
<PlatformExtension>
<EventMap>
<Event name="percepiodemo:simpleuserevent"” type="UserEvent">
<Parameter name="channel" var="channel"/>
<Parameter name="val" var="val"/>

</Event > [Eh Settings ﬁ
< / E ve ntMa p > LTTng UST Extensions LTTng UST Extensions
</PlatformExtension> er |
Remove

name: the Tracealyzer name for this parameter
var: the name of the LTTng tracepoint

Parameter name “"channel” has special meaning, specifies
the User Event Channel name.

This example is available in Help menu -> ”LTTng UST Example”
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Advanced: Tracing your own “Kernel Services”

| dema.out: 5141 |

—-—— sem_post{0x0804C198) |

| demo.out: 5142 I

sem_wait(0x0804C198) returns after 2788312 ps |

[ _kworker/0:0: 4345 |

E konsole: 3082 |

demo.out: 5142 |

+---—————1 sem_wait{0x0B804C198) blocks |

Tracealyzer can be configured to display LTTng events from any function call as "Kernel
Services” which enables many functions like Kernel Object History and matching of related
events. This requires three steps...
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Step 1. Record the function calls with LTTnhg

$ LD PRELOAD=./wrapper.so ./prog

prog.c wrapper.so Library
ptr = malloc (64); > malloc > malloc
LTTng

void* malloc(size t size) // wrapper for malloc
{

void* ret;

static void* (*realmalloc) (size t size) = NULL;

if (realmalloc == NULL)
realmalloc=dlsym (RTLD NEXT, "malloc");

ret = realmalloc(size);

tracepoint (percepio, malloc, size, ret);
return ret;

With tracepoints in wrapper functions and using LD_PRELOAD, the code don’t
need to be changed or even recompiled. The dynamic linking will route the calls
to the new wrapper function, which calls LTTng plus the original function.
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Step 2. Create a Platform Extension XML file for the
new LTTng events

<Platformextension>
<TargetPlatform>
<KernelServiceGroups>
<KernelServiceGroup name="UST"> - the group name showed in the View Filter
<KernelService name="sem_wait" operation="IncreaseSemaphore"”> - The name and meaning of event
<Parameter name="sem"/>
</KernelService>

</KernelServiceGroup>
</KernelServiceGroups>
<ObjectClasses>
<ObjectClass name="PthreadSemaphore" type="Semaphore"/> - Type and display name of object class
</ObjectClasses>
</TargetPlatform>
<ObjectMap>
<Object class="PthreadSemaphore” format="0x{@:X8}"/> - How to format identifiers for such objects
</ObjectMap>
<EventMap> - Mapping between LTTng events and kernel services calls
<Event name="percepio:sem_wait_entry" service="UST/sem_wait" type="Entry" status="Detect">
<Parameter name="sem" var="sem" class="PthreadSemaphore"/>
</Event>
<Event name="percepio:sem_wait_exit" service="UST/sem_wait" type="Exit" status="Success">
<Condition cvar="ret" cval="0" cop="8&1lt;" target="status" value="Timeout"/> - if (ret < 0) status = “Timeout”;
</Event>

</EventMap>
</PlatformExtension>

This example is available in Help menu -> ”LTTng UST Example”

percepio

SENSING SOFTWARE




Step 3. Import the Platform Extension

( [Eh Settings @ h

LTTng UST Extensions LTTng UST Extensicns

Percepiollema Add

PercepioWrapper

[0k | Conce




Questions?

support@percepio.com
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